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Your technology helper for over 30 years. 

(BUSSLINE is the term for the complex multi-
functional circuitry on a computer mother-
board, a PC’s heart.) 

Sunday, June 16 
The amazing Oz is sure to have an excellent presen-
tation, in spite of my awful headline pun.  
  
A past president of CFCS, Oz Rugless is a world 
traveling speaker and trainer for all things Microsoft, 
with wonderful personal stories to tell, along with 
practical computer tips you can use NOW. If you 
bring your laptop, you can use them even as he 
speaks. 
 
You will go home from this meeting enthused once 
more about this wonderful computer habit of ours, 
your pockets packed with notes on the many new or 
rediscovered programs Oz will tell us about, and the 
new magical insights he has shown us.           
 
Author of a Microsoft Press book, 101 Microsoft 
Visual Basic .NET Applications, Oz has spoken at 
our meetings before, always to an enthusiastic 
crowd, some of whom actually come back from the 
retirement from their retirement just to hear him. 
Be sure to check out Oz’s website, rugless.com, 
where you will find out about some of the many tips 
and tricks and freebies he will tell us about on Sun-
day, usually updating it just for us after the meeting.
  
CFCS launches new SIG! 
Officially classified as a Special Interest Group 
(SIG) chaired by Mike Ungerman (whose brainchild 
it is), OUR NEW sig is actually a new Google Group 
email feature that will allow members (only) to post 
any items they may have for sale or items that they 
would like to purchase or trade.  Similar to the exist-
ing CFCS Tech-SIG and CFCS iSIG groups, mem-

(Continued on page 2) 
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bers of the group may send an email to the group ad-
dress, and it will be sent out to other members either 
as an immediate email or as a daily digest of emails 
from that day.  
 
Membership in the group is limited to CFCS members 
only, so we won't be getting spam listings.  Any mem-
bers desiring to take advantage of an offer or request 
will be doing so between themselves. CFCS is not a 
party to the transaction, nor a mediator if there is a 
dispute over an item or payment.  There are no restric-
tions as to what a member may post to sell, so perhaps 
it's time to clear out that garage, back room, attic, 
etc.  You can even announce a garage sale if you want 
to get rid of a lot of stuff! 

To join the group, click or enter this URL into your 
browser: 

http:/ /groups.google.com/ group/
cfcs_for-sale_wanted?hl= en 
 

OUR OTHER SPECIAL  
INTEREST GROUPS (SIG) 

 
The ACCESS, MS OFFICE, and SECURITY SIGs 
meet conjointly on the second Wednesday of each 
month from 7 to 9 pm at the New Horizons Learning 
Center at 1221 Lee Rd. Arvin Meyer, a Microsoft 
MVP (Most Valuable Professional), (and current 
CFCS president), leads the SIG. http://groups. ya-
hoo.com/group/cfcs-access  This is a combination of 
three separate SIGs which now meet conjointly for the 
duration of Arvin’s presidency. They will resume 
separate meetings when he leaves office. 
 
The VIRTUAL DIGITAL PHOTO & VIDEO SIG 
lead has been assumed by Hewie Poplock and and it 
meets on the 3rd Wednesday of every month, by invi-
tation. To register go to https://apcug.ilinc.com/perl/ilinc/
lms/event.pl 
 
Choose Virtual Photo SIG June 2013  
  
The TECH DISCUSSION SIG meets on the fourth 
Tuesday of each month from 7 to 9 pm at the Cassel-
berry Denny’s at 436 and Oxford Rd. SIG leader is 

Stan Wallner, President Emeritus. 
 
This SIG is a non-structured, open conversational group 
for CFCS members, that has no specific topic or 
speaker, but is simply a round table discussion. It is not 
an advanced group, but a place for people to come and 
discuss various tech subjects, such as new products and 
technologies, hardware, software, web-related, etc.  
 
Bring in articles from magazines, newsletters, unusual 
problems/situations that have arisen, questions, etc. 
Also, new or ailing devices or notebook pc's are wel-
come, either for "show and tell" or discussion or demo 
of situations.  
 
A screen and projector are available, but not always 
there.  If you want it to demo something,  please E-mail: 
tech-sig@cfcs.org a day or 2 ahead. 
 
Another feature of this SIG is the Tech-SIG Yahoo 
Group mail.  We now have 64 people communicating 
through this, with tips and tricks, "Ask-It Basket" type 
questions, etc.  Also, a second, on-line VIRTUAL meet-
ing of the TechSIG is being experimented with on the 
second Tuesday of each month.  Co-hosted by Mike 
Ungerman and Stan Wallner, it may attract a long dis-
tance audience. Stay tuned to the e-Blast for times and 
details - it is not yet permanently scheduled, but will be 
announced in the e-BLAST and on theTech-SIG Yahoo 
Group mail.  If you are not on that list and want to 
be,  please E-mail: tech-sig@cfcs.org  
 
The iSIG meets on the third Monday of each month 
at 7:00 PM at Florida United Safety Council,  
1505 East Colonial Drive, Orlando FL 32803. 
This building is located across from the Publix on Colo-
nial Drive in the Colonialtown section of downtown Or-
lando. They have secured WiFi and vending machines 
are available. The iSIG meetings cover the products that 
use the iOS, which includes the iPhone, iPad, and 
iPod Touch. This is a combined effort of the Central 
Florida Computer Society http:// www.cfcs.organd the 
Florida Macintosh Users Group http:// www.flmug.com. 
Other groups are invited to participate. Attendees are 
consumers, developers, consultants, and publishers, who 
find common interests and discuss how to handle topics 
from both the consumer & the developer perspectives. 
The SIG leader is Sean Kane, Certified Apple Technical 
Coordinator, long-time Mac and iOS user, and a tech-
nologist and consultant to The Walt Disney Company.  
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Internet Scammers Take 
Advantage of Boston and 
Texas Disasters 
by Ira Wilsker 
 
WEBSITES: 
https://www.bbb.org/us/article/BBB-Warns-of-Charity-
Scams-Offers-Giving-Tips-in-Wake-of-Boston-
Marathon-B-41366 
https://www.bbb.org/charity-reviews/national/ 
http://money.cnn.com/2013/04/17/pf/boston-marathon-
charity/index.html 
http://www.boston.com/business/personalfinance/
consumeralert/2013/04/
beware_boston_marathon_bombing.html 
http://www.firstcoastnews.com/news/article/309527/0/
Email-scam-disguised-as-Boston-Marathon-news-
makes-the-rounds 
http://www.domainnews.com/en/boston-marathon-
blasts-see-cybersquatters-exploit-tragedy.html 
https://dallas.bbb.org/article/after-west-texas-explosion-
bbb-offers-tips-on-giving-and-warns-of-potential-scams-
41438 
http://www.antiscamnews.com/texas-fertilizer-plant-
explosion-spam/ 
` 
 Americans are a generous people.  In times of dis-
aster or crisis countless Americans have always heeded 
an internal call to do good and contribute to those in 
need.  The recent terrorism in Boston which resulted in 
at least three dead from the bombings, as well as over 
170 injured, many losing limbs, has encouraged Ameri-
cans to open their hearts and wallets to help those casu-
alties.  Donations are also pouring in to help the family 
of the murdered MIT campus police officer, and the 
critically wounded Boston Transit officer, allegedly at 
the hands of the two suspected bombers.  Even the 
owner of the boat that turned out to be the final refuge of 
the surviving terrorist, has received unsolicited dona-
tions from concerned citizens intending to replace his 
$55,000 boat, which was riddled with police bullets in 
the final shootout. 
 Just days after the Boston Marathon bombings, a 
fertilizer plant in West, Texas, exploded, leading to over 
a dozen deaths (including several volunteer firefighters), 
many injuries, and extensive property damage.  As Tex-
ans always have done in a crisis situation, along with 
many other Americans, contributions have flooded relief 

The Recycle Bin 
by Stan Wallner,  
President Emeritus, CFCS 
    
Stan, a CFCS member since 1984, has 
served in many offices over the years, 
and is now on the BOD as President Emeritus. Sepa-
rately, he is a local IT consultant, "“PC Doctors Make 
House Calls," offering his services on-site, at your office 
or home - for PC and Laptop Upgrades, WiFi, Net-
works, Virus & Spyware removal, Troubleshooting both 
hardware & software, at reasonable rates (discounts for 
CFCS members!). You can contact him at smwall-
ner@yahoo.com or 407-862-2669.  
  
Recycling is a MOST important issue regarding our en-
vironment, and can't be over-emphasized! It is an area 
that is changing frequently, so check for this column 
regularly! When there are changes, we will print them. 
Meanwhile, check the website at cfcs.org for the column 
as it has run for the past few issues of the BUSSLINE. 
 
NEW TREASURER APPOINTED 
A new treasurer has been appointed by the CFCS Board 
of Directors. His name is Don VanDemark, and he 

comes to us 
via the Drupal 
SIG. Jay Ja-
cobs has al-
ready started 
training him.  
W e l c o m e 
aboard, Don.  
 

 
 
 

BUY YOUR INK at : 
cfcs.InkRaiser.com 
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MEMBERSHIP RENEWAL  
Membership renewal invoices will be e-mailed from 
treasurer@cfcs.org approximately thirty (30) days prior 
to your membership expiration. Invoices will be snail 
mailed to members for whom there is no e-mail address 
in the membership database and to those members 
whose e-mail was returned to treasurer@cfcs.org for 
any reason. Please help us by adding this address to 
your contacts list and setting your spam filter to let our 
message get to your inbox. We do not share your e-mail 
address with others (We hate that too!), but it is neces-
sary for full participation in the Society, including receiv-
ing your newsletter.  
Members will be requested to renew their membership 
by paying dues on time. Dues may be paid by cash or 
check at the meeting, by PayPal at http://
www.cfcs.org/membership/membership.php or by 
mailing a check to: 

  CFCS 
  204 Larkwood Drive Ste 100 
  Sanford, FL 32771-3643 
 
If you do not receive a renewal invoice, lose it or have 
questions about your dues and or membership status, 
please inquire at the sign-in table or send an e-mail to: 
treasurer@cfcs.org.  

Membership Cards: A new membership postcard with 
the membership card included for the next year will be 
distributed at the meeting following your renewal. The 
Cards will be mailed to those members who request 
same by e-mail to treasurer@cfcs.org. 

tations are actually a 
"phishing" scam, 
where the email or 
social media alert 
appears to be from a 
legitimate and well 
known charitable 
organization, but 
instead links to a 
counterfeit but au-
thentic looking web-
site complete with 
an online donation 
form.  In addition to 
collecting credit card 
data, which can then 
be resold to other 
cyber crooks, some 
of these bogus web-
sites also collect 

(Continued on page 6) 

organizations helping the victims of the explosion.  
Americans really are a generous people. 
 Inevitably, there are always a bunch of crooks 
who illicitly siphon off funds intended to help disaster 
victims, and following these two tragedies these miscre-
ants again crawled out of the woodwork to steal funds 
intended to benefit the victims.  Among the first organi-
zations to sound the alarm warning about these bogus 
charity schemes allegedly raising money to help the 
Boston Marathon victims was the Better Business Bu-
reau (bbb.org/us/article/BBB-Warns-of-Charity-Scams-
Offers-Giving-Tips-in-Wake-of-Boston-Marathon-B-
41366), which as soon as Tuesday, April 16, the day 
after the Boston bombings, warned donors about the 
charity scams.  In the April 16 press release from the 
BBB, it said, "At least one poorly-conceived charity 
scam has already emerged in the wake of the explosions 
at the finish line of the Boston Marathon yesterday, and 
more are likely. BBB Wise Giving Alliance 
(“Alliance”), the national charity monitoring arm of the 
Better Business Bureau,  ... cautions donors about po-
tential red flags concerning tragedy-related philan-
thropy."  H. Art Taylor, president and CEO of the 
BBB's Wise Giving Alliance warned, “Tragedies inspire 
people to give, but, tragedies – whether natural disasters 
or manmade catastrophes – also inspire scammers to 
take advantage of that generosity. Social media, in par-
ticular, makes it very easy to reach a lot of people 
quickly, when emotions are running high and people 
feel the need to take action, any action, to help.”  Since 
that preliminary warning from the BBB, several other 
questionable websites, 
email campaigns, Face-
book and Twitter re-
quests, and other bogus 
fund raising activities 
have appeared, all in-
tended to misdirect well 
intentioned contribu-
tions into the pockets of 
fraudulent charities and 
thieves. 
 According to the 
BBB, there may be 
much more than simple 
theft of charitable funds 
that the concerned citi-
zen intends for the vic-
tims of tragedy.  Some 
of the email and social 
media charitable solici-
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THE CENTRAL FLORIDA COMPUTER SOCIETY is a 
charitable, scientific and educational, nonprofit organization, 
founded in 1976 and incorporated in 1982 to encourage interest in 
the operation and development of computers through meetings 
with free exchange of information and educational endeavors. 
 
Newsletter: The CFCS Newsletter © 2008 is the official 
newsletter of the Central Florida Computer Society, Inc. It is 
published every month by CFCS for the purpose of keeping 
members and others informed of computer-related news and 
activities of the Society. Circulation: 25,000. 
 
Mailing Address:  
CFCS 
204 Larkwood Dr., Suite 100 
Sanford FL  32771 
Membership: CFCS membership includes participation in the 
Society's activities and subscription to this  Newsletter. 
            
Annual Dues Schedule:  
    Individual  ……………………….$   25 
    Extra family member  ..…….…..      15 
    Student (Full time)………………     15 
    Corporate membership……..…..    100* 
 *Includes free business card ad  
 
Members are responsible for sending a change-of-address 
notification (including e-mail) to:  
membership@cfcs.org. 
 
Gifts to CFCS are welcome, and because of the Society's nonprofit 
tax status, are tax deductible. 
 
Meetings:  CFCS meets  each month on the  3rd Sunday at 2:00 
p.m. at the Jackson Hewitt Training Center, 2221 Lee Rd. 
Winter Park, FL  The Jan. Feb. and Mar. meetings are held at 
another location. Guests and the general public are invited to 
attend. Special Interest Groups (SIGs) within the Society meet 
regularly. See Special Interest Groups listings on pages 6 & 7. 
 
CFCS Web site:          www.cfcs.org 
 
Editorial:  Articles for publication in the CFCS Newsletter should 
be emailed  to the Editor at: editor@cfcs.org. Please use Microsoft 
Word format, Times New Roman font, 12 point, if possible. The 
deadline for submitting articles is the first of each month. 
 
Articles by authors other than directors of CFCS and the 
Newsletter staff do not necessarily reflect the policies or sanction 
of the Society.  Unless otherwise indicated, articles in the CFCS 
Newsletter may be reprinted in newsletters of other nonprofit 
organizat-ions, without permission, provided credit is given.  
  
This issue was created using Microsoft Office    2003 and MS 
Publisher 2003 Edition. ◙ 

 

                       Newsletter  Committee 

Chairpersons and Coordinators 

Interested in making a difference?   
Then volunteer with CFCS!  The programs and 
benefits that members receive would not exist 
without members also volunteering.  There are 
vacancies for a Program Chair/Coordinator, Edu-
cation Chair and Advertising Chair. Please con-
tact Arvin Meyer, if you have any questions, com-
ments, or suggestions. president@cfcs.org 
     

 Special Interest Groups Ken Larrabee 407-365-2660  sigs@cfcs.org 
 APCUG Hewie Poplock  apcug@cfcs.org 
    
 Education (Open) (e-mail only) education@cfcs.org 
 FACUG Arvin Meyer  facug@cfcs.org 
 Hardware Manager Arvin Meyer 407-327-3810 hardware@cfcs.org 
 Helpline Volunteers Griff Moore (e-mail only) helpline@cfcs.org 
     
 Membership    Jay  Jacobs 407-328-2766 membership@cfcs.org 
 Photographer Robert Black 407-421-4213) photographer@cfcs.org 

 Program Coordinator Stan Wallner (temp) (e-mail only) programs@cfcs.org 
 Reviews (S/W & Books) Mike Ungerman (e-mail only) reviews@cfcs.org 
 Webmaster Cheryl Wilson    (e-mail only) webmaster@cfcs.org 

                      CFCS is associated with both  
     International & Florida User Group Associations: 

  www.apcug.net 

Editor: Robert Black  

Associate Editor:  

Proofreader:  CFCS BoD  

Distrib:   Stephen Constant Advertising: (Needed)  

Computer ready  rates, for one time insertion, whether in the Printed or 
Electronic Edition:  
           Full Page            $200.00*               Quarter Page       $75.00*   
           Half Page             125.00*                Business Card      25.00* 
Advertising deadline: the first day of month of issue. Electronic copy is 
required.   
All ad copy and correspondence should be sent by email to:  advertis-
ing@cfcs.org 
*Annual Rates, Paid in Advance, for 12 insertions, with a minimum of 2 
Printed 
Editions:  Full Page        $1200*                  Quarter Page        $450     
               Half Page           750                    Business Card          150 
*Does not include Back Page;  please inquire if interested  

              CFCS Newsletter Advertising    

                              Board of Directors 

President      Arvin Meyer 407-327-3810 president@cfcs.org 
Vice Pres.     Jack Pearson 407-880-7339 vicepresident@cfcs.org 
Secretary       Bess MacConnell 407-644-3852 secretary@cfcs.org 
Treasurer      Carlton  Jacobs 407-328-2766 treasurer@cfcs.org   
Director 1      Tom Ault             407– 247-9165        dir1@cfcs.org 
Director 2      Ted Goodwin 407-894-1180 dir2@cfcs.org 
Director 3      Forrest Cheek 407/629-4139  dir3@cfcs.org 
Newsletter Editor     Robert Black 407-421-4213 editor@cfcs.org 
President Emeritus      Stan Wallner      407-862-2669          presidentemeritus@cfcs.org 
SIG Chair      Ken Larrabee 407-365-2660 sigs@cfcs.org 
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other personal information in order to commit identity 
theft.  Some of these illicit websites may also load mal-
ware onto the unsuspecting donor's computer.  I would 
suggest that if a 
donor desires to 
make a contribu-
tion to one of the 
recognized na-
tional charities, 
first check out the 
charity on the 
BBB's charity re-
view website at 
www.bbb.org/
charity-reviews/
national, and then 
go directly to that 
charity's website 
and make the do-
nation directly.  I 
do not recommend 
clicking on links 
sent in emails or 
posted in social 
networking pleas, as these 
can easily be forged, and 
result in the criminal di-
version of the donation. 
 In a news alert pub-
lished in Domain News, 
an industry publication 
(domainnews.com/en/
boston-marathon-blasts-
see-cybersquatters-
exploit-tragedy.html),  
is a story headlined 
"Boston Marathon Blasts 
See Cybersquatters Ex-
ploit Tragedy".  Within 
hours of the bombings, 
well over one hundred 
domain names were regis-
tered with some permuta-
tions of the Boston mara-
thon bombing.  Domain 
News says, "Within half 
an hour the domains Bos-
tonBombing.com, Boston-
Bombing.net, Boston-
Bombing.org, Boston-
Bombing.us and Boston-

Bombing.info were all registered according to Domainer 
Income and within an hour there were over 125 domains 

registered relating 
to the blasts.  
While a few of 
these domains are 
possibly going to 
be used for genu-
ine charitable or 
other efforts, the 
majority are des-
tined to be used as 
scam-related web-
sites.  Scam web-
sites set up using 
the domain names 
may be for 
fraudulent charita-
ble websites or 
provide links to 
malware-infected 
sites."  Similar 
Twitter and Face-
book accounts 

were also quickly cre-
ated, some of which pro-
moted donations to a 
variety of supposed 
charities.  Some of these 
websites and social me-
dia pleas contained 
graphic news photos or 
edited images intended 
to tug at the heartstrings 
of generous people by 
displaying supposed 
photos of dead or badly 
injured victims, includ-
ing the eight year old 
fatality.  Donations were 
solicited in the names of 
these victims, but in 
most of these appeals, 
any donations go di-
rectly to a scammers ac-
count. 
 The devastating 
fertilizer plant explosion 
in West, Texas, just two 
days after the Boston 
Marathon bombings, 
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also brought out the scammers trying to deceive gener-
ous people into making financial donations to the crooks.  
Jeannette Kopko,  a spokesperson for the BBB in Dallas, 
which covers the region where the fertilizer plant was 
located, warned, "It’s unfortunate that scammers prey on 
consumers’ sympathies after a tragedy like the West, 

Texas, explosion in order to swindle consumers. Scams 
could range from questionable charity appeals to phony 
websites, emails, social media accounts or messages, and 
even to home or business repair scams.” (Source: dal-
las.bbb.org/article/after-west-texas-explosion-bbb-
offers-tips-on-giving-and-warns-of-potential-scams-
41438).  What is especially sad in the above BBB state-
ment is the fact that those who had significant property 
damage could be doubly victimized; first by the explo-
sion itself, and then by " ... home or business repair 
scams.” 
 Also, just like following the Boston bombings, 
internet scammers started to plunder those wishing to 
help the folks in West, Texas by making financial dona-
tions to them or to legitimate charitable support organi-
zations.  According to a report published in Anti Scam 
News (antiscamnews.com/texas-fertilizer-plant-
explosion-spam), it was less than 12 hours after the 
shocking videos of the fertilizer plant blast appeared on 

 
 
 
 
 
 
Sanford store is located at 1617 WP Ball Blvd. in the 
Marketplace of Seminole Town Center (407-688-
7627). Near Target; between Bright Now Dental & 
Firehouse Subs 

Apopka  store is in Victoria Plaza, at 1087 W. Or-
ange Blossom Trail. (407-814-3935) This is just past 
the 429,  in the same Plaza as the Harbor Freight.  
Both open 9-7 Mon.-Sat. Closed Sundays  
5% discount on most non-sale items for CFCS members 
 

 2013 FACUG Computer User Group Cruise   

Royal Caribbean’s 5-Star Independence of the Seas 
Saturday, December 7 - Sunday, December 15, 2013 

Sailing from Fort Lauderdale, calling on Philipsburg, St. Maarten; 
Basseterre, St Kitts; San Juan, Puerto Rico and Labadee, Haiti then re-
turning to Fort Lauderdale. 
  
REGISTRATION IS STILL OPEN    
9-day/8-night  Caribbean cruise as low as $654.67 
The Technology Conference@Sea registration fee is $95/person for 
members of a FACUG or APCUG club ($120 for non-members) and 
also $95 for the second person in the cabin, who need not be a club 
member.  More at facug.org 
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the news that email boxes started to receive the initial 
flood of spammed scams soliciting donations for the 
people of West, Texas.  According to the report, "Within 
12 hours of the explosion, my email account received 
spam with “Texas plant explosion” in the subject line. 
The first one arrived just after 8 am today (4/16). Since 
then, I’ve received subsequent versions with slight 
variations in the subject line.  A search of the link in-
cluded in these emails shows it reported as a virus, with 
the same type of links also used for emails about the 
very recent tragedy at the Boston Marathon. ... This mal-
ware has been reported by a Kaspersky Lab expert, who 
explains that the initial link, which is disguised as a 
“news” story, opens a YouTube video. After a 60 sec-
ond delay, another link to an executable file is activated, 
which contains the virus.  BEWARE – Do NOT click 
links to any supposed news stories in any emails you 
receive. This type of Malware is also being spread 
through Social media sites like Facebook. To read up-
dates on news stories, go to known and trusted news 
sites." 
 It is really sad that there are people in society who 
exist by taking unfair advantage of well intentioned and 
generous people who sincerely desire to help others in 
need.  By being aware of the scams and threats posed by 
illicit charity and news websites, as well as spam emails, 
perhaps we can be better assured that our donations will 
reach the intended victims, and our personal information 
and computers will not be compromised. 
 

Windows Q&A  
By Mary Phillips, Secretary, 
ICON Users Group, MO   
January 2013 issue, The ICON 
www.iconusersgroup.org 
mary@iconusersgroup.org 
 
Q1. My email account may have been hacked, phished, 
or compromised. How can I tell for sure?  
 
A1. It’s pretty obvious when friends start asking if you 
sent them “such and such” and you definitely didn’t that 
spam stuff that your address book in your email has 
been hacked. (If you receive email from “yourself” that 
you didn’t send, then it may be someone else’s email 
that was hacked and your address was in their address 
book.) 
 
Other ways to suspect that your email has been compro-

mised are that you can’t log into your email account or 
you’re not receiving email that you should be. If you’re 
finding in your Sent email folder items you didn’t send, 
someone without permission may have been sending 
“spam” emails (unrequested ads, etc.) or “phishing” 
emails (fake emails asking for your ID, password, birth 
date, bank account number, etc.) using your ID and 
password. This unauthorized person might also be send 
“scam” emails (emails asking you to help them get 
money to or from a foreign country). 
 
Q2. What should I do if I’m pretty sure my email ac-
count has been compromised?  
  
A2. The first thing to do, if you can get into your ac-
count, is change your password to a completely new 
password that contains at least one of each: capital let-
ter, lower case letter, number, and special character (-, 
_, &,*, #, etc). These four requirements should 
give you a strong password that’s not easy to crack. If 
you can’t get into your account, you will probably have 
to call the provider of your email or get other profes-
sional help. 
 
The next step is to scan your computer(s) with an up-to-
date anti-virus program.  
 
Scan again with an up-to-date anti-spyware/antimalware 
program such as SuperAntiSpyware because some mal-
ware may not be detected by anti-virus scans. 
 
Run your Microsoft Updates to make sure the operating 
system is up-to-date.  
 
When you’re sure the computer(s) are clean, you may 
want to change the email password again just in case a 
“keylogger” malware program (program that records 
and sends “home” every key stroke you’ve made) had 
been installed on the computer and was active before 
you got everything cleaned. 
 
Log into your email and check to see that your Options 
haven’t been changed in webmail. 
 
Note: Also, it’s safer NOT to check in the box to let the 
browser “Remember my password.” 
 
Q3. I downloaded the Internet Explorer 10 for my Win-
dows 7 machine and I don’t like it because it’s causing 
problems. How can I get rid of IE 10 and get my IE 9 
back? 
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A3. Actually, when IE 10 is uninstalled, IE 9 is auto-
matically restored. To uninstall IE 10, follow the path: 
Strata Control Panel / Programs and Features. In the left 
panel, click on “View installed updates.”  
 
Under “Uninstall and update” scroll down to the Micro-
soft Windows section, select Internet Explorer 10 and 
click “Uninstall.” 
 
Restart the computer to complete the removal of IE 10 
and restore IE9.   
 
Q4. I want to create an index with hyperlinks to individ-
ual pages in a newsletter, booklet or document in MS 
Publisher. How do I do it?  
  
A4. To create a hyperlink to another page in your docu-
ment, do the following:    
1. Select either text or a picture. 

2. On the Standard toolbar, click Insert Hyperlink.  
3. Under Link to, click Place in This Document.  
4. Select the page that you want and change the title of 
the page if you like.   
5. Click OK on the Enter Text dialog box. Click OK in 
the Insert Hyperlink dialog box.  

 
In the example below, after selecting the page Windows 
Q & A in the index, clicking on the hyperlink button, 
clicking Place in This Document, clicking the page num-
ber, clicking Change Title button, I have changed the 
Page Title to “Windows Q & A.” I will click OK twice.  
 
Now, if the file is a .pub  opened in a Publisher program, 
when the mouse pointer is positioned on Windows Q & 
A in the index, the pointer will stay an I-beam, but a tool 
tip will appear briefly stating to use Ctrl + click to follow 
the link.  

 
 
However, if the file is a .pdf opened in Adobe Reader, 
the pointer will become the hand with the pointing finger 
to indicate a link, and a click takes you immediately to 
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page 4.  
 
Q5. How do I adjust an inserted picture to get it very 
close to the text in MS Word or MS Publisher 2007? 
 
A5. In MS Word, do the following:  

Right-click on the graphic for a menu and select For-
mat Picture. 

Click the Layout tab, and then click the Advanced 
button. 

For Wrap style, click on Tight or Square—Tight ad-
justs for Left and Right, Square adjusts also Top 
and Bottom. Select horizontal position for the 
graphic (Left, Center, Right, Other).  

Click Advanced. 
Change the Distance from Text to “0”. Click OK. 

Click OK.  
Nudge the selected graphic (resizing handles show-

ing) to the desired position with the navigation 
arrow keys. (When a graphic has been formatted 
this way, you can usually click and drag it or 
nudge it wherever you want it; but sometimes 
you have to delete and reinsert it.) 

 
For MS Publisher 2007, right-click the graphic, select 
Format Picture, and click the Layout tab. 
 
Then, select Wrapping Style – Square allows adjustment 
for Distance from text. Next, select the position to wrap 
text, and set the Distance from text to something be-
tween 0” and 0.04”. 
 
Q6. How do I adjust the Line Spacing in MS Word and 
Publisher 2007 to get more text to fit on a page? 
 
A6. Click the Line Spacing button and make adjust-
ments as needed. The Paragraph dialog box below 
shows the selected paragraph is aligned Flush Left, with 
no space before paragraphs, a 4pt space after paragraphs, 
and a single space between lines. 

 
 
Windows 8:  
Big differences from Win7, and it works! 
By Karen Stagg, Member, Golden Gate 
Computer Society 
March 2012 issue, GGCS newsletter 
www.ggcs.com 
editor@ggcs.org 
 
Windows 8 is substantially different from previous ver-
sions of Windows, and, though it requires a learning 
curve, the task is not insurmountable, says GGCS mem-
ber Ernie Ganas, who helped about 75 guests and mem-
bers understand the newest Microsoft operating system 
(OS) during the February General Meeting. 
 
To make the newness more palatable, Ernie offered that 
this new OS takes only 15 to 20 seconds to boot and 10 
seconds to shut down. And the Internet loads instantly. 
 
In addition, Windows 8, which costs about $200, is a 
stable platform—more so than previous versions of Win-
dows, which has been a concern since even-numbered 
Windows upgrades have notoriously had problems in the 
past. Windows Defender is standard in Windows 8 and 

Back by popular demand: 

"bring a friend day” Sunday 
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Be a smart guy. You could pay your yearly 
dues to CFCS simply by making computer 
related purchases at Smart Guys Computers. 
Buy a laptop, or less, get free dues! 

replaces Microsoft Security Essentials. 
 
The online app store for Windows 8 has 35,000 choices 
to purchase online, though many are free. 
 
The term “apps” is starting to replace the word 
“programs” but can still be used interchangeably. 
 
Be aware that many of the default applications or prefer-
ences are made by Microsoft, i.e. Bing instead of 
Google. If you don’t like Bing, you can choose Google 
(or another search engine), and Lock your choice in 
Internet Options>Tools. 
 
Windows 8’s (Pro version or higher) unique feature 
called “Windows to Go” (WTG) allows you to boot 
your workspace from a USB flash drive, so you can see 
your desktop as you would see it at home—your files, 
programs, etc.—on any computer you plug into. If you 
need to use someone else’s computer, say, while travel-
ing, WTG builds a virtual box that holds your Windows 
environment. Your information is never on that com-
puter; it’s all just on your flash drive. 
 
The logon screen, though inconvenient to some, does 
serve a purpose. It allows a user to sign into a different 
computer and have their home configuration (including 
references) visible. 
 
Windows 8 also helps us access our data by promoting 
the use of cloud storage with Sky Drive, available in 
various size options. Ernie suggests that the trend in 
computer security may be to virtual environments to 
protect computers better. 
 
How it looks and works The new Task Manager is well-
designed, showing useful information not available with 
previous Windows versions. The initial start-up screen 
shows many icons such as: 

Weather 
Maps 
People 
Mail 
Games 

 
But the “search” feature is the fastest way to find any-
thing (apps, settings or files) on your Windows 8 com-
puter, Ernie says. 
 
Windows 8 stores your data in a “pool.” It gathers files 
and data from multiple sources such as your flash 

drives, hard drives, or other storage mediums. The only 
drawback is that once the data is transferred to the pool, 
you can no longer determine from what device the infor-
mation was transferred from. 
 
Windows 8 was made to be used with a touch screen 
monitor, but those of us (the majority attending the 
meeting) still have the conventional screens and can 
handily navigate Win 8 with a mouse or touchpad. 
 
To return to the “Tiles” view, use the Windows key on 
the keyboard. To close a tile, the screen offers no obvi-
ous place to click Close. Instead, for those with a touch-
screen, hold your finger at the top of the screen and 
“brush” the screen down or toward you, as if you were 
brushing something off the screen itself. To do this ac-
tion with a mouse, click and hold at the top of the 
screen, then drag the window down instead of 
“brushing” it. Old timers remember the Alt + F4 key-
stroke works too. 
 
Users with touchscreen experience on an iPhone or An-
droid, iPad or, tablet will be familiar with “brushing” or 
“sliding” motions. Ernie speculates that the computer 
industry is headed toward a tablet/phone touchscreen 
interface. 
 
The touchscreen and decidedly visual platform isn’t in-
tuitive. Ernie’s first challenge was figuring out how to 
start, restart, and shut down—he found no button in an 
obvious place. Windows 8 does offer some right-click 
options for shut down and closing a window. Finding 
them is another matter. In addition, Ctrl + Alt + Delete 
doesn’t work in this version of Windows. 
 
John King, one of our well-schooled computer buffs, 
responded to Ernie’s request for an experienced assess-
ment of this new system: “It is a stretch to learn this sys-
tem.” Fortunately, the Microsoft store in Corte Madera 
is well set-up for customers to learn how to use all the 
bells and whistles in their products. Ernie suggests You-
Tube as a valuable source for tutorials. 
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Under the  
Computer Hood  
By Greg Skalka, President, Under the 
Computer Hood User Group, CA 
February 2013 issue, DriveLight 
www.uchug.org 
president@uchug.org 
 
Misery from Social Media 
Does Facebook make you miserable? I know I get de-
pressed when I think about all the time people waste on 
social media sites, spending hours looking at what other 
people are doing or raising imaginary crops on Farm-
ville. I get perturbed when I read about those bird-brains 
that spend all their time tweeting their every action, and 
the twits that follow them. I’m not sure what is higher on 
the worthless scale in that case, being the tweet-er or the 
tweet-ee (at least the tweeter is writing something). 
 
Now there may be proof that all this social media con-
nectivity is bad for our mental health. A joint study con-
ducted by two German universities indicates that use of 
social media sites like Facebook causes increased feel-
ings of envy. Researchers reported  
that one in three people felt worse and more dissatisfied 
with their lives after visiting these sites. “We were sur-
prised by how many people have a negative experience 
from Facebook, with envy leaving them lonely, frus-

trated or angry”, said researcher Hanna Krasnova from 
the Institute of Information Systems at Berlin’s Hum-
boldt University. 
This is not very surprising to me. The tendency of most 
people to post mostly positive information about them-
selves, their families and their activities, and leave off 
the unflattering bits tends to skew what is seen on these 
sites. I’m sure some use social media as the high tech 
way to brag. When faced with glowing reports of 
friend’s lives and activities and beautiful photos of their 
latest adventures, a viewer’s feelings of inadequacy 
seem a reasonable result of the social media experience. 
The study did report that vacation photos posted by oth-
ers was the biggest cause of resentment. How surprising. 
Second was social interactions, where being able to 
compare against others the number of birthday greetings 
received or comments and “likes” on photos and  
posts produced envy. 
 
The researchers noted that these feelings of envy 
prompted users to boast more about their own activities, 
which I would think would result in more angst overall 
for Facebook users, as everyone competes to report hav-
ing the most impressive lives. It reminds me of the feel-
ings I recall having when my wife and I would go out to 
tour model homes on the weekends, not to buy but to get 
decorating ideas for our own home. We would leave our 
house feeling reasonably satisfied with it, but interested 
in making it just a little better. We would return from 
touring these fabulously decorated and ridiculously neat 
model homes with the feeling that our house was a 
dump. It would have been better for our mental health 
and overall happiness if we had never gone looking. I 
wonder if we will someday find it is the same with so-
cial media? 
 
A Hard Drive In Your Pocket 
Ignore those that say you can’t take it with you - now 
you can. When you need to carry around a lot of data, 
Kingston is there for you. They announced the 1 TB 
version of the DataTraveler HyperX Predator 3.0 flash 
drive at CES, which is expected to be available in the 
first quarter of this year. It will allow you to carry a hard 
drive’s worth of data with you and access it at USB 3 
speeds. You will have room in your pocket for it, how-
ever, as the price will empty your pockets, wallet and 
more. “Greg’s Rule of Flash Drive Pricing” says not to 
pay more than $0.50 per GB for flash drive storage, and 
you can do that for drives up to 32 GB. Unfortunately, 
the 512 GB version of this drive is priced at $1300 

(Continued on page 13) 

Free in-store diagnostics on your computer 
Free telephone tech support 

Lowest price name brand computers in the U.S.A. 
 
THREE LOCATIONS: 
1) near UCF,   2) on 434 near 17/92,    3) in the Villages.  
         Details at refreshcomputers.net/ 
 
5% discount on most non-sale items for CFCS members 



June, 2013 CFCS BUSSLINE NEWSLETTER PAGE 13 

($2.50 per GB), and the 1 TB version is expected to 
fetch over $2500, about what you would pay for 35 1 TB 
3.5” hard drives. 
 
The Extermination of the Mouse 
Those of us that were at the January general meeting at 
the Microsoft Store in the Fashion Valley Mall saw a 
demonstration of Windows 8 on a large display screen 
connected to a touch screen computer. The touch screen 
is one way to get rid of the mouse in our computing 
lives. Another way is coming from a company called 
Leap Motion (http://www.leapmotion.com/). They are 
producing a product that will allow you to interact with 
your computer without a mouse, using hand gestures 
similar to those controlling the computers shown in the 
movie Minority Report. Think of it as a Microsoft Ki-
nect interface for your hands only. You can interact with 
your computer through hand waves, pinches and other 
gestures more intuitive than a mouse can allow. You can 
pre-order their 3D hand gesture control capability for 
$69.99. The small hardware motion  
controller, the size of a pack of gum, plugs into a USB 
port and sits in front of your monitor. With the Leap Mo-
tion software, they claim it can track individual finger 
movements to 1/100th of a millimeter. If this becomes 
real like Kinect, it could make the mouse obsolete.  
 
What’s Going into the Gadget Graveyard by 
the End of 2013? 
My column last month contained my predictions for the 
next year. One of them was that desktop and laptop com-
puters would continue to hold their own against the on-
slaught of tablets and smart phones. I’m happy to report 
that my prediction is in line with the 2013 Gadget 
Graveyard predictions made by IEEE, the world’s larg-
est technical professional organization. Their survey of 
IEEE members, engineers, engineering students and 
CES attendees predicts that desktop computers should 
live on for at least another year. 
 
Smart phones also will not yet force cameras, car keys or 
GPS systems into the gadget graveyard. What are most 
likely to head for extinction are entertainment devices 
like CDs, radios, MP3 players, DVDs and cable boxes, 
as streaming services for audio and video continue to 
gain in popularity. The consensus was that paper-based 
items, including printers and paper money, would be 
around a while longer. 
 
I think I will hang onto my DVDs and MP3 players, as 
they may provide the only entertainment I will get this 

year. The problem with Internet streaming services is 
bandwidth, and in just one month I’ve found mine to be 
more limited than I thought. I’ve got cable Internet at 
home that typically shows a 12 Mbps or greater 
download speed (often approaching 20 Mbps), but re-
cently I was confronted with web pages that would not 
load on my computer. Something was bogging down my 
Internet access. I went downstairs to find my wife 
watching an episode of Downton Abbey on her Kindle 
Fire HD tablet, while my son was downloading some-
thing on his Google Nexus tablet. It is kind of like the 
water we San Diegans get from the Colorado River. 
 
At the state line it is an impressive flow, but if enough 
users turn on the tap at the same time, all I’m likely to 
get is a trickle. All these new tablets are thirsty for band-
width, so I may need to wait until everyone has gone to 
bed before I can pay the bills online. Meanwhile, as they 
are screaming for more bandwidth, I can watch my 
DVDs on my laptop in peace (as long as I have on my 
noise canceling headphones, that is). 
 
A Warning from the Cable Company  
As if limited bandwidth isn’t bad enough, I recently re-
ceived a warning from Road Runner / Time Warner that 
I had an infected computer. When I tried to access the 
Internet through a browser, a web page popped up that 
appeared for be from Time Warner. It appeared in the 
same manner that an initial web page would on a hotel  
Internet connection, requiring a log in or acceptance of 
terms before proceeding to the Internet. This page 
warned me that they had “received a report of suspected 
virus activity from a machine connected to the cable mo-
dem” on my Internet connection. The page provided 
links to Microsoft’s free Malicious Software Removal 
Tool, as well as McAfee anti-virus software that I could 
download for free as a subscriber. It also warned me that 
I could be in violation of their Acceptable Use Policy 
and could have my access suspended. To proceed to the 
Internet, I had to click on a button that indicated I was 
aware of this issue and would clean and secure my com-
puters. 
 
I regularly scan my computers for viruses and malware, 
but occasionally have guests, like my son’s girlfriend’s 
laptop, connected to my network. I was also not sure 
how regularly my son maintains his PCs. I persuaded my 
son to install a free antivirus to take the place of his ex-
pired software, but he found no infections. I scanned my  
laptop and desktop, but found no problems there. When I 
scanned my wife’s desktop, the antivirus did find some-
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thing that was reported as part of a trojan, and eliminated 
it. 
 
I don’t know if that was the “reported” problem, or how 
it was that a problem was detected by the cable com-
pany. The web message said to contact my local cable 
office for further questions regarding this incident, but 
knowing how much fun it is to try to get useful informa-
tion out of them over the phone, I never made an attempt 
to learn more. So far my cable Internet access has not 
been cut off. 
 

Hurricane Season Has 
Started - Keep Track 
and Stay Safe Using 
Your Computer 
by Ira Wilsker 
 
WEBSITES: 
http://www.nhc.noaa.gov 
http://www.nhc.noaa.gov/mobile/      
Mobile link for smart phones and other devices 
http://www.srh.noaa.gov/lch/ 
http://www.accuweather.com/en/hurricane 
http://www.weather.com/weather/
hurricanecentral 
http://www.weather.com/services/
mobilesplash.html   Mobile apps and links 
http://www.wunderground.com/tropical 
http://www.beaumontweather.com 
http://www.weather.navy.mil 
http://www.weather.gov/os/hurricane/
resources/TropicalCyclones11.pdf 
http://www.ready.gov/hurricanes 
https://play.google.com/store/apps/details?
id=com.cube.arc.hfa (Red Cross Hurricane 
 App for Android) 
https://play.google.com/store/apps/details?
id=Hurricane.Software  (Android Hurri-
cane  Software) 
 
June 1 started our official annual hurricane 
season, which will continue until it offi-
cially ends on November 30.  Last year on 
the upper Texas Gulf coast, we were fairly 
lucky in that our region was not struck di-
rectly by a major storm, but the memories 
of Rita, Ike, Katrina, Isaac, and other disas-

trous storms are still fresh in the minds of many of us.  
As computing power and information has been exponen-
tially increasing, and computer model forecasting has 
greatly improved, hurricane warnings and projected 
tracks have become more accurate with greater advanced 
warning.  Major providers of hurricane information have 
increased both the quality and availability of online in-
formation, allowing us users of computers and smart de-
vices to have immediate access to the latest storm pro-
jections enabling us to better prepare for severe tropical 
weather; this information may be a literal life saver. 
 
There is a plethora of public (government) and private 
organizations and websites that provide comprehensive 
current hurricane and tropical weather information.  Ar-
guably, the premier source of hurricane and tropical 
storm information is the National Hurricane Center 
(nhc.noaa.gov), a Miami based division of the National 
Weather Service.  With the fiscal and material resources 
available as a federal agency, the National Hurricane 
Center (NHC) offers the most comprehensive informa-
tion and data available.  For those using mobile devices 
with web access, such as smart phones or tablets, the 
NHC offers a mobile version of its website at 
nhc.noaa.gov/mobile.  Alerts and updates are also avail-
able in text format, by email, and RSS (news) feeds, as 
well on the major social media networks.  The NHC is 
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obviously making this information 
available as quickly as possible to the 
widest audience. 
 
On the front page of the NHC website 
is an abundance of easy to follow in-
formation that is usually updated at 
least every six hours, but more fre-
quently as conditions warrant.  Typi-
cally at the top of the page is a com-
posite image that shows potential 
storms that may form within the next 
48 hours, as well as the odds of each 
suspicious area becoming a tropical 
storm or hurricane during that time 
period.  Clicking on the "Graphical 
Tropical Outlook", "Active Storms", 
or "Marine Forecast" links at the bot-
tom of the "Atlantic Tropical Cyclone 
Activity" image will open another 
page with that particular information 
clearly displayed both as a graphical 
image, and as a text file explaining 
what is shown.  For those interested 
in the details of what is going on in 
the tropics, that Atlantic Marine Fore-

casts page offers an interac-
tive selection offering de-
tailed information on tropi-
cal weather in the Gulf of 
Mexico, Caribbean, and on 
the Atlantic High Seas.  
When an area of suspicious 
or threatening tropical 
weather exists, additional 
images are displayed below 
the Atlantic Marine Fore-
casts display.  As I am typ-
ing this, there is an area of 
disturbed weather in the 
central Gulf which is dis-
played in a colorful chart 
showing land boundaries, 
color enhanced cloud tops, 
wind flow, and the pro-
jected short term bounda-
ries of the shower and thun-
derstorm area. 
 
When a tropical depression, 
tropical storm, or hurricane 
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occurs, the NHC provides a massive amount of addi-
tional data to the public and the media.  On the main 
NHC webpage there will be a thumbnail summary of a 
variety of charts and graphs covering three 
and five day projected tracks, predicted wind 
field and wind strength, watches and warn-
ings, and other important information.  It is 
this graphical and text information that is dis-
played by most of the media, and studied by 
local forecasters and emergency management 
officials. 
 
For those individuals who prefer independ-
ently compiled storm information, there are 
several major commercial weather services 
and web pages that prepare their own charts, 
graphs, and predictions; sometimes these in-
dependent tropical projections differ or con-
tradict what the official government agency 
(the NHC) announces.  Probably the best 
known of these private weather services is the 

(Continued from page 15) 
Weather Channel, and its companion website 
weather.com.  The Weather Channel has a dedicated 
"Hurricane Central" webpage at weather.com/weather/
hurricanecentral which typically has videos, stories, 
maps, charts, and other helpful information.  The 
Weather Channel. being a commercial operation, offers 
what may be the most comprehensive support for smart 
devices.  On its mobile page at weather.com/services/
mobilesplash.html, the Weather Channel lists free smart 
phone apps for iPhone, Android, Blackberry, and Win-
dows Phone devices.  For those using mobile browsers 
with any operating system, the Weather Channel offers a 
webpage optimized for the  mobile web at weather.com/
services/mobile-web.html.  With the popularity of tablet 
devices, there are also apps for iPads and Kindle Fire 
tablets.  With countless people massively communicat-
ing via text messaging, the Weather Channel offers a 
free sign up for weather related text messages, localized 
by city or zip; the signup link for these free text mes-
sages is at the bottom of the mobile page. 
 
A private, independent weather service widely used by 
many in the media and corporate world is AccuWeather, 
which offers its own proprietary graphics and predic-
tions on its hurricane page at accuweather.com/en/
hurricane.  AccuWeather is a feisty company, with an 
excellent reputation, and a very loyal following.  Accu-
Weather also has free apps for almost all smart devices, 
including BlackBerry, Windows Phone, Windows 8, 
iPad, Android, iPhone, and other devices.  The links for 
these apps can be found at the bottom right of the Accu-
Weather webpage. iPhone users might especially appre-
ciate the AccuWeather iPhone app; according to the list-
ing on iTunes, the app was,  "Voted “Best iPhone App” 
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hurricane information, this Red 
Cross app provides information 
on open emergency shelters, 
can send "I'm safe" alerts to 
family and friends, provides the 
ability to use a phone as a flash-
light and emergency strobe, and 
other benefits. 
 
Another specialized free hurri-
cane app I have on my Android 
phone is "Hurricane Software", 
which is a highly rated, free , 
comprehensive storm informa-
tion app.  According to its web-
site, this " ... hurricane tracking 
application give(s) you the most 
up to-date and reliable hurri-
cane coordinates data and high 
resolution maps, satellite Im-
ages, warning information, 
storm tracks and more." 
 
In the infancy of the internet, in 

March, 1994, I created my own comprehensive, local-
ized weather page, beaumontweather.com.  I believe that 
my non-commercial weather page is the longest, con-
tinuously running Beaumont based website.  During hur-
ricane season, beaumontweather.com displays storm pro-
jections, spaghetti charts (projected tracks from multiple 
sources), wind maps, storm surge predictions, satellite 
images, and other storm information, much of it in real-
time.  My page also displays current local and regional 
weather conditions, radar animations, emergency infor-
mation, evacuation maps, and massive amounts of other 
information.  Since this is a non-commercial website, 
there are no paid ads or other irritants displayed. 
 
With all of the contemporary weather and tropical infor-
mation available online, the old fashioned paper tracking 
charts are somewhat obsolete as a prediction tool.  With 
all of this information readily available on a host of de-
vices, we all have access to current information that may 
literally be lifesaving. 
 

Support our Advertisers.  Tell them you 

saw their ad in the CFCS Newsletter! 

by the 2012 Mobie awards, AccuWeather for iPhone 
now has popular features from our AccuWeather for 
iPad app, current conditions that refresh every five min-
utes, and more! Users tell us it is their “Go-to weather 
app.” From what to wear to how to travel, they say they, 
“Can’t live without it,” and it is, “Better than any other.” 
 
Since many people are now using smart devices, such as 
smart phones, as their primary data and communications 
devices, it is inevitable that a large selection of dedicated 
hurricane apps would be developed for those smart de-
vices. As stated above, the Weather Channel and Accu-
Weather have apps for just about all smart devices, they 
are not the only apps available.  For most devices there 
are several highly rated free apps specifically for hurri-
cane tracking.  My personal favorites for my Android 
phone are "Hurricane - American Red Cross" and 
"Hurricane Software".  The Red Cross hurricane app is 
one of an integrated series of free Red Cross apps that 
cover a variety of emergency issues, including first aid, 
tornado, earthquake, and wildfire events.  The Red Cross 
hurricane app is among the most acclaimed and awarded 
emergency apps: "One of the top 6 hurricane tracking 
apps - CNN"; Readers’ Pick: Most innovative and useful 
hurricane app – FastCompany; One of 5 apps to get you 
through a natural disaster – Fox News; Top Apps of the 
Week (11/3/12) – ABC News".  In addition to providing 
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the computer.   
 
Sign into SkyDrive and click the kind of document to 
create in the Create drop down menu. In the dialog box 
type a name for the document and click the Create but-
ton.  
 
A new document opens for editing in the appropriate 
Web App. Simply create the document as you would in 
the Office application. The Web App will not have the 
full features of the Office 2010 application but is famil-
iar.   
 
Share Files on SkyDrive  
SkyDrive allows you to share your Office documents, 
photos and other files. You can share individual files or 
an entire folder.  In SkyDrive locate the folder or file to 
share and place a check in the selection box. Click Shar-
ing on the Menu bar. The default method of sharing is 
by email. This lets you give specific people permission 
to access and even edit your files. Add the email ad-
dresses for those who will be reviewing the files, add a 
message and click the Share button. To access the docu-
ment the recipients must have an account or create one.  
 
The Post to option places a link to your SkyDrive files 
on a social media service like Facebook. I wouldn’t 
choose this method of sharing as it is open to any of 
your friends or their friends if they repost.  
 
The Get a link sharing option creates a link you can send 
to others. The advantage is they do not need to have a 
SkyDrive account. The disadvantage is that anyone with 
the link can access the file. I would use the View only 
option for sharing a link. It allows anyone with the link 
see the file. The View and Edit link allows anyone with 
the link to see and edit the shared files. If you select 
Public sharing anyone can search for and view the pub-
lic files. 
 
Share Files on SkyDrive  
SkyDrive allows you to share your Office documents, 
photos and other files. You can share individual files or 

an entire folder.   
 
In SkyDrive locate 
the folder or file to 
share and place a 
check in the selec-
tion box. Click Shar-
ing on the Menu bar. 
The default method 

 
SkyDrive & Office Web Apps  
By Lynn Page, Editor/Webmaster,  
Crystal River Users Group, FL 
March 2013 Newsletter issue 
www.crug.com 
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With a Windows Live ID you have access to Micro-
soft’s Office Web Apps. This lets you open, edit and 
share Word, Excel and PowerPoint documents online 
using SkyDrive. So you can work with your documents 
from any computer whether it has the Office applica-
tions installed on it or not. Go to http://
skydrive.live.com in a web browser to log on or sign up 
for a Windows Live account.  
 
Store Office documents on SkyDrive to view and edit 
them in a browser. Or share documents stored on Sky-
Drive by linking to them in an email, blog or social net-
work.   
Save to or Upload to SkyDrive Documents generated on 
your home computer can be saved to SkyDrive or up-
loaded. Use Save & Send to save an existing Word, Ex-
cel, or PowerPoint file. Select Save to Web, Sign in to 
your Windows Live Account, and then click OK. Spec-
ify a folder on SkyDrive, and click Save As. Type a 
name for the file and click Save.   
 
I think it is easier to create the document save it on the 
hard drive and then upload it to SkyDrive. In the Sky-
Drive menu bar click Upload. Then either drag and drop 
files from your Documents folder to the upload box or 
browse to and select them for upload. To open a docu-
ment in SkyDrive, select the folder where document is 
saved, and click the file name.   
 
Create New Documents in the Web Browser  
With the Office Web Apps you can create Word, Excel 
or PowerPoint files right in a web browser. The Office 
application doesn’t have to be open or even installed on 
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of sharing is by email. This lets you give specific people 
permission to access and even edit your files. Add the 
email addresses for those who will be reviewing the 
files, add a message and click the Share button. To ac-
cess the document the recipients must have an account or 
create one.  
 
The Post to option places a link to your SkyDrive files 
on a social media service like Facebook. I wouldn’t 
choose this method of sharing as it is open to any of your 
friends or their friends if they repost.  
 
The Get a link sharing option creates a link you can send 
to others. The advantage is they do not need to have a 
SkyDrive account. The disadvantage is that anyone with 
the link can access the file. I would use the View only 
option for sharing a link. It allows anyone with the link 
see the file. The View and Edit link allows anyone with 
the link to see and edit the shared files. If you select Pub-
lic sharing anyone can search for and view the public 
files. 
 
Organize/Manage SkyDrive  
SkyDrive storage can be managed in a similar way as 
Documents on your hard drive. A new SkyDrive account 

will have three folders: Documents, Pictures and Public. 
Create new folders with the Create drop down menu. 
Folders can be nested within these three main folders or 
added on the main file location. Go to the location to add 
a folder, click Create and select Folder from the drop 
down menu. Enter a name for the folder and it is all set 
for storing files. The path to the files or folders is shown 
in the title bar. The number in the bottom right corner of 
a folder shows the number of files it contains. 
 
If you change your mind about how folders should be 
organized you can move them. To move a folder, go to it 
in SkyDrive. On the Mani menu click Folder actions and 
select Move folder to from the drop down menu. In the 
dialog box add a new folder or select the location to 
move the folder.  
 

The Manage drop down menu is used to manage files. It 
allow for renaming, deleting, moving and copying files. 
The trick is that you must go the folder containing the 
file and place a check in the selection box. That opens 
additional commands on the Menu bar.  
To move the file place a check in the selection box (top 
right corner), click Manage in the Menu bar and select 
Move to in the drop down menu. In the dialog box select 
the location for the file to be moved. 
 
Word Web App 
The Home tab contains basic text and paragraph format-
ting including Styles.   
 
The Insert tab is used to insert tables, pictures, clip art 
and links. To insert a table in 
the Insert Table drop down point to the number of rows 
and columns and click.  
Clicking the Picture icon opens Windows Explorer to 
select a picture to insert into the 
document. Browse to and select the picture and click 
Open. The picture is uploaded 
and inserted into the document.   
 
Clicking the Clip Art icon opens a search box. Type in a 

description and click the search sym-
bol. Browse through the clip are 
pieces, select one and click the Insert 
button.   
Once a picture or clip art has been up-
loaded a Picture Tools Format tab ap-
pears when the graphic is selected. 
Tools are available to Grow or Shrink 
the picture and add a Picture Style.   

 

 
 



                                  June, 2013      PAGE 20 CFCS  BUSSLINE NEWSLETTER 

The Page Layout tab specifies page setup and para-
graph indent and spacing. Page Setup options include 
margins, page orientation and size.  
 
Save the document when it is complete. Clicking Save 
on the File tab saves it on your SkyDrive. Clicking 
Save As allows you to download a copy and save it on 
your hard drive.  
 
Excel Web App 

 
The Home tab has font formatting and alignment, num-
ber formatting and table formatting. The Cell com-
mands allow for insertion or deletion of rows, col-
umns, cells and new sheets. The Formulas group in-
cludes the commonly used functions. The Data group 
can refresh the workbook connections and recalculate 
or search the workbook to Find something. 

 
Insert Functions, Tables, Charts and Links from the In-
sert tab. The number of charts available is limited but 
sufficient.   
 
The View tab has only two options. You can use the 
standard Editing View or choose Reading View to look 
at the data without toolbars. 
 
PowerPoint Web App  
When creating a PowerPoint presentation on the web 
app there a very limited number of themes. In the first 
dialog box chose a theme. There are also four customize 

buttons that change the color scheme. Once the theme 
has been set and the Apply button clicked a new presen-
tation opens.  
The Home tab has the Clipboard, Slides, Font, Para-
graph and Drawings groups. The font and paragraph for-
matting commands are limited to the basic functions. 
The number of shapes is limited but you still have 
styles, fill and outline. I like the new Delete group as it 
provides one click option to delete a slide. 
 
 
The Insert tab has a New Slide button to open the dialog 
to select a slide style to add to the presentation. Adding 

pictures and clip art 
is same as in the 
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Word Web App. Shapes and SmartArt are added in the 
Illustrations group. 

 
The Text group contains the Text Box icon. 
 
The Design tab offers the same themes and variations 
shown in creating the presentation. So if you decide that 
the selected theme isn’t working change it to one more 
suitable. Set the animation on the slide and timing or re-
order the animations on the Animation tab. Slide transi-
tions are limited to none, fade and push and are con-
trolled on the Transitions tab. The View tab has three 
Presentation Views as well as Notes and Comments. The 
Editing View is the normal view you would use in 
PowerPoint with slide icons for selecting or sorting and 
the active slide pane. The other options are Reading 
View and Slide Show.   
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    May 2013 General Meeting 
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Please Note - This is a service for CFCS MEMBERS ONLY   HelpLine Listings 

     

   HelpLine is a free service to members of CFCS only. The following volunteers have offered to field questions by phone or via e-
mail with software and hardware problems listed below.   Please be considerate of the volunteer you are calling.   

 
    As a free service, you should not be asked to pay for help or be solicited for products or services. If anything to the contrary 

occurs, please contact the HelpLine coordinator immediately.  Their names will be removed from the list.  
 
    Additional volunteers are needed in some existing categories and for new categories.  If you are interested, please contact the 

HelpLine coordinator at e-mail:  helpline@cfcs.org 

  
        

  Digital Photography & Video     
     Ken Larrabee  407 365-2660         anytime 
     KLarrabee@cfl.rr.com 
    
 DOS       
     Stan Wallner   407-862-2669        5 pm-7 pm 
     smwallner@yahoo.com 
     
    Kris Hestad   321-459-2755  
     kris.hestad@surfdogs.com 
     
 Hardware 
     Ken Larrabee  407-365-2660         anytime 
      
   Stan Wallner   407-862-2669        5 pm-7 pm 
    smwallner@yahoo.com 
 

 
 MS ACCESS 
   Arvin Meyer, MVP  407-327-3810      7 pm - 9 pm 
   Access-sig@cfcs.org 
 

 
 MS Office Products: 
  MS Word, Excel, Power Point, Outlook and Access 
  Doug Gabbard (e-mail only)    
  Dougga@gmail.com 
 
 Security 
 Arvin Meyer  407-327-3810 
 Access-sig@cfcs.org 
 
   Networking - Home or Office 
 Doug Gabbard    e-mail only   
 Dougga@gmail.com 

 
SQL-Server 
Arvin Meyer  407-327-3810 
Access-sig@cfcs.org 
Windows 
Hewie Poplock  407-362-7824 5 pm-7 pm 
hewie@hewie.net 
 
Kris Hestad   321-459-2755     
kris.hestad@surfdogs.com 
 
WinZip 
Arvin Meyer  407-327-3810 
Access-sig@cfcs.org 
Wireless Routers 
Kris Hestad   321-459-2755  
kris.hestad@surfdogs.com 
 

 

HelpLine 
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June 2013 

July 2013 

Cancelled, this 

month only. 
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Support our Advertisers.  Tell them you 
saw their ad in the CFCS Newsletter! 

     DIRECTIONS TO MONTHLY MEETING 
Our meeting building is at the intersection of 
Lee Road and Turner Rd. The meeting is in the 
building behind the one on the corner of Lee 
and Turner. Turn North on Turner, left into the 
parking lot, and drive behind the office building 
in the rear of the parking lot. You will see a sign: 
Jackson Hewitt delivery entrance. Plenty of 
parking is nearby, and the meeting room is just 
inside, making it accessible for those with spe-
cial mobility equipment.  

 
SPECIFIC DIRECTIONS  
based on your starting point. 
From I-4, exit at lee Rd., drive East 1/2 mile 
to Turner Rd. and turn left onto Turner and 
left again into the first parking lot. Drive to 
the rear of the rearmost building and look for 
the Jackson Hewitt delivery entrance. 

From Apopka/436 area, go south on 441 to 

Lee Rd., Go about 2 miles, past I-4, then turn 
left onto Turner and left again into the first 
parking lot. Drive to the rear of the rearmost 
building and look for the Jackson Hewitt de-
livery entrance.  

From the SouthWest, take John Young to 
Lee Rd. as above, turn left on Turner and left 
again into the first parking lot. Drive to the 
rear of the rearmost building and look for 
the Jackson Hewitt delivery entrance. 

From Hwy 17-92, drive to Lee Rd, turn West, 
then go 8/10ths of a mile to Turner Rd. and 
turn right. Drive to the rear of the rearmost 
building and look for the Jackson Hewitt de-
livery entrance.  


